TrapTracker

User’s Guide
Contents

About this Guide ................................................................................................................................. vi
Purpose of this guide .......................................................................................................................... vi
Who should read this guide ............................................................................................................... vi
Typographical Conventions ............................................................................................................. vi
Document Revision Control ........................................................................................................... vii
How to Get In Touch ....................................................................................................................... viii
Documentation Support .................................................................................................................... viii
Customer Support ............................................................................................................................ viii

Chapter 1 Getting Started.............................................................................................................. 9
What is TrapTracker for Windows? .................................................................................................. 10
TrapTracker Components ................................................................................................................ 10
  TrapTracker Manager ................................................................................................................... 11
  MibCompiler ................................................................................................................................. 11
Starting TrapTracker for Windows ................................................................................................ 12
TrapTracker Manager Console ....................................................................................................... 13
Working with Trap Windows ........................................................................................................... 16
  Creating a New Trap Window ...................................................................................................... 16
  Renaming a Trap Window ......................................................................................................... 20
  Cascading Trap Windows ........................................................................................................... 22
  Tile Trap Windows Horizontally ............................................................................................... 23
  Tile Trap Windows Vertically ...................................................................................................... 24
  Closing a Single Trap Window .................................................................................................... 25
  Closing All Trap Windows .......................................................................................................... 25
  Viewing Window Properties ....................................................................................................... 26
  View All Trap Details in the Notepad ......................................................................................... 27
  View All Trap Details in a Window ............................................................................................. 28
  View Trap Details of a Selected System ..................................................................................... 30
Clearing/Acknowledging Trap Details ............................................................................................ 32
  Clear/Acknowledge a single trap ................................................................................................. 32
  Clear/Acknowledge Multiple Traps ............................................................................................. 32
  Clear/Acknowledge All Traps of a Selected System ................................................................... 33
Auto Scroll ........................................................................................................................................ 33
  Viewing New Trap ....................................................................................................................... 33
Adding a New System ..................................................................................................................... 34
Upgrading License ........................................................................................................................... 35
Exiting TrapTracker .......................................................................................................................... 36

Chapter 2 Managing Traps ......................................................................................................... 37
Auto-Acknowledge Traps .................................................................................................................. 38
Filtering Traps from View ............................................................................................................... 39
Adding Trap Filter ........................................................................................................................... 39
# Contents

## Chapter 4 Tools

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying Trap Filter</td>
<td>42</td>
</tr>
<tr>
<td>Deleting Trap Filter</td>
<td>44</td>
</tr>
<tr>
<td>Alerts</td>
<td>45</td>
</tr>
<tr>
<td>Adding Alerts</td>
<td>45</td>
</tr>
<tr>
<td>Configuring Audible Alert action</td>
<td>48</td>
</tr>
<tr>
<td>Configuring E-mail Alert action</td>
<td>51</td>
</tr>
<tr>
<td>Configuring Console Message Alert action</td>
<td>53</td>
</tr>
<tr>
<td>Executing Custom Alert action</td>
<td>55</td>
</tr>
<tr>
<td>Modifying Alert Configuration Details</td>
<td>58</td>
</tr>
<tr>
<td>Deleting Alert Configuration Details</td>
<td>62</td>
</tr>
</tbody>
</table>

## Chapter 3 Reports & Categories

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing Trap Categories</td>
<td>64</td>
</tr>
<tr>
<td>Creating Trap Category</td>
<td>64</td>
</tr>
<tr>
<td>Monitoring Custom Categories</td>
<td>70</td>
</tr>
<tr>
<td>Modifying Category Details</td>
<td>73</td>
</tr>
<tr>
<td>Deleting Category</td>
<td>74</td>
</tr>
<tr>
<td>Adding Trap Details to a Trap Category</td>
<td>75</td>
</tr>
<tr>
<td>Modifying Trap Details in a Trap Category</td>
<td>78</td>
</tr>
<tr>
<td>Deleting Trap Details from a Trap Category</td>
<td>79</td>
</tr>
<tr>
<td>Import and Export Trap Categories</td>
<td>80</td>
</tr>
<tr>
<td>Exporting Trap Categories</td>
<td>80</td>
</tr>
<tr>
<td>Importing Trap Categories</td>
<td>82</td>
</tr>
<tr>
<td>Reports</td>
<td>83</td>
</tr>
<tr>
<td>Generating Reports</td>
<td>84</td>
</tr>
</tbody>
</table>

## Chapter 4 Tools

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is SM?</td>
<td>93</td>
</tr>
<tr>
<td>What is SNMP?</td>
<td>93</td>
</tr>
<tr>
<td>What is MIB?</td>
<td>95</td>
</tr>
<tr>
<td>MIB-II Tree</td>
<td>96</td>
</tr>
<tr>
<td>Groups of MIB-II</td>
<td>97</td>
</tr>
<tr>
<td>SNMPv1 Datatypes</td>
<td>98</td>
</tr>
<tr>
<td>SNMPv2 Datatypes</td>
<td>100</td>
</tr>
<tr>
<td>SNMPv2 Object Definition Enhancements</td>
<td>100</td>
</tr>
<tr>
<td>Textual conventions for SNMPv2</td>
<td>101</td>
</tr>
<tr>
<td>UDP</td>
<td>102</td>
</tr>
<tr>
<td>SNMP PDU</td>
<td>102</td>
</tr>
<tr>
<td>MibCompiler / Browser</td>
<td>103</td>
</tr>
<tr>
<td>Scope</td>
<td>103</td>
</tr>
<tr>
<td>References and Terminology</td>
<td>103</td>
</tr>
<tr>
<td>Architectural Overview</td>
<td>104</td>
</tr>
<tr>
<td>Functional Definition</td>
<td>104</td>
</tr>
<tr>
<td>Starting MibCompiler</td>
<td>105</td>
</tr>
<tr>
<td>Understanding MibCompiler Console</td>
<td>106</td>
</tr>
<tr>
<td>Need for MIB Compilation</td>
<td>109</td>
</tr>
<tr>
<td>Compiling a Single MIB Module</td>
<td>110</td>
</tr>
<tr>
<td>Compiling Multiple MIB Modules</td>
<td>113</td>
</tr>
<tr>
<td>Saving MIB Compilation Report</td>
<td>116</td>
</tr>
<tr>
<td>Viewing MIB Details</td>
<td>116</td>
</tr>
<tr>
<td>Viewing Trap Details</td>
<td>117</td>
</tr>
<tr>
<td>Browsing MIB Tree</td>
<td>119</td>
</tr>
<tr>
<td>Searching Trap Details</td>
<td>123</td>
</tr>
</tbody>
</table>
About this Guide

Purpose of this guide
This guide educates the end-user to understand the interface better and to work with the application efficiently without any hassles.

Who should read this guide
The targeted audience:
- Network Administrators, who are designated to monitor and manage the health of mission critical networks, RDBMS and applications.
- Technical support personnel who can identify the problems and take appropriate action before adverse situations happen.

Typographical Conventions
Before you start, it is important to understand the typographical conventions followed in this guide:

<table>
<thead>
<tr>
<th>This</th>
<th>Represents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Italics</td>
<td>References to other guides and documents.</td>
</tr>
<tr>
<td>Bold</td>
<td>Input fields, radio button names, check boxes, drop-down lists, links on screens, menus and menu options.</td>
</tr>
<tr>
<td>CAPS</td>
<td>Keys on the keyboard and buttons on screens.</td>
</tr>
<tr>
<td>{Text_to_customize}</td>
<td>A placeholder for something that you must customize. For example, {Server_Name} would be replaced with the name of your server/machine name or an IP address.</td>
</tr>
<tr>
<td>Constant width</td>
<td>Text that you enter, program code, files and directory names, function names.</td>
</tr>
<tr>
<td>☰</td>
<td>A note, providing additional information about a certain topic.</td>
</tr>
</tbody>
</table>
Document Revision Control

Document Revision Control is an alphanumeric acronym. The components of the acronym identify the following:

- First two letters – name of the product
- Second two numbers – version of the product
- Third two numbers – build of the product
- Last four letters – document description

\[\text{TT 4.072 USGD}\]

Name of the Product: TrapTracker

Document Description: Updated in accordance with release version 4.0 build 72.

Table 2

<table>
<thead>
<tr>
<th>File Name</th>
<th>TrapTracker v4.0 b72 User Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Updated in accordance with release version 4.0 build 72.</td>
</tr>
<tr>
<td>Status</td>
<td>Final</td>
</tr>
<tr>
<td>Release Date</td>
<td></td>
</tr>
</tbody>
</table>

The document revision control for this guide is as given below:
How to Get In Touch

The following section provides information on how to obtain support for documentation and software.

Documentation Support

We welcome your honest comments and thoughtful suggestions about the quality and usefulness of this document. For further questions, comments and suggestions on this documentation, contact us at support@prismMicroSys.com.

Customer Support

For technical assistance regarding TrapTracker for Windows, contact us at support@prismmicrosys.com. While contacting technical support, please have the following information ready:

- Your name, e-mail address, phone number and fax number
- Topology of the network, type of hardware and the configuration you administered
- Version of TrapTracker for Windows
- Operating system
- The error message you encountered or any other error messages that appeared on your screen
- Description of how you tried to fix the problem
Chapter 1
Getting Started

In this chapter, you will learn how to:

- Start TrapTracker for Windows
- Work with Trap Windows
- Work with Traps
- Upgrade License
- Exit TrapTracker
What is TrapTracker for Windows?

The Simple Network Management Protocol (SNMP) is today a de-facto industry standard for monitoring and managing devices on data communication networks, telecommunication systems and other globally reachable devices. Practically every organization dealing with computers and related devices aims to centrally monitor, diagnose and configure each such device across local and wide area networks. SNMP is the protocol that enables this interaction.

TrapTracker for Windows [TTW] is a scalable, standard-compliant framework that receives traps send by the SNMP compliant devices. TTW provides options to categorize traps, generate custom reports and configure notifications on occurrence of a specific trap.

TrapTracker for Windows helps the user to:

- Monitor, consolidate, and analyze traps sent by SNMP compliant devices
- Parse MIB (based on ASN-1 format) files.
- Retrieve object and trap definitions from MIB file. This implies that MIB modules describing the traps are compiled to facilitate the translation of SNMP PDUs into user understandable format. Traps that cannot be translated should not be discarded, but should be displayed and stored in raw format.
- View the contents of MIB files in a format easily understood by the user.
- Compile and store multiple MIBs in a single file.
- Collect and consolidate Trap details, Category details and Alert details into the database.
- Configure real-time notification by E-mail, beep, and custom action.
- Conform to audit requirements suggested by GLBA, HIPAA, Sarbanes-Oxley Changing Client Service Account, California Senate Bill 1386, the USA Patriot Act and NISPOM.

TrapTracker Components

TTW version 4.x has the following components.

- A background process that receives and processes generic SNMP v1 and v2 traps; send by SNMP compliant devices.
- Feature-rich GUI application to categorize traps, filter traps for customized views, configure Alerts, upgrade license etc
- A MibCompiler
**TrapTracker Manager**

TrapTracker Manager is the nerve center of the framework. It collects SNMPv1 and v2 traps sent by various SNMP compliant network devices, validates and logs them into the database and checks whether any Alert needs to be performed. The TTW Manager employs the MibCompiler to translate the traps received by TrapTracker Receiver service at port 162 into user-friendly names.

The GUI enables the user to:

- View live System window that provides information about trap activity on all monitored devices. Whenever a device generates traps, the criticality of the traps is indicated by visual indicators in the All Traps window as well as in the Systems window. The System window also provides a view, where only the latest traps that occurred on the system can be viewed and acknowledged.
- Filter Traps for view by setting criteria
- Acknowledge the traps that are viewed. The acknowledge traps are cleared from view, but are committed to the database. The TrapTracker Manager automatically acknowledges traps that are older than a specified time frame.
- Spawn multiple new windows on the console with each window showing only traps that match its own selection criteria.
- Script User Notes for any specific Trap. The User Notes is useful to keep track of what action was taken for a Trap, before the trap was acknowledged (cleared from view). The Notes entered here are visible in the reports/history.
- Import and Export Categories
- Generate customized reports

**Note**

By default, the TTW Manager uses port **162** to listen for SNMP traps sent by SNMP compliant devices.

Database is the repository of all received traps, configured Alerts and other configuration data.

**MibCompiler**

The collection of related objects implemented by a system is called an MIB: Management Information Base. All network resources that are to be monitored are described in the form of objects using ASN-1 language and stored in a MIB file.

MibCompiler is responsible for parsing an input MIB file and checking its syntax and semantics for any error (if present). After successful compilation, it keeps object
information in binary format, which is used by TTW Manager from SNMP PDUs to traps translation.
The MibCompiler/Browser helps in compilation of custom MIBs into the TTW system.

Starting TrapTracker for Windows

To start TrapTracker Manager

1. Double-click TrapTracker on the Control Panel.

TrapTracker displays the TrapTracker Manager Console.

If the number of unacknowledged traps exceeds the window view limit, TrapTracker displays the “Select View Option” dialog box.
2 To view only the recent traps, select the **Load Recent Traps (up to maximum traps view limit, currently 1000)** option.

3 To view new traps that are not logged into the database, select the **Show Only New Traps (logged traps will not be loaded for view)** option.

### Note

TrapTracker does not display the “Select View Option” dialog box at the first instance you start the TrapTracker Manager Console.

4 Click **OK**.

---

**TrapTracker Manager Console**

This section covers a conceptual overview of the TrapTracker Manager console. It helps you understand the menus and general interface of the TrapTracker Manager.
Title Bar
The top strip of the TrapTracker window is the Title Bar. The Title Bar shows the name of the application.

Menu Bar
The menu bar contains menus with relevant commands. From the menus, choose appropriate commands or use shortcut keys to execute commands.

Toolbar
The toolbar contains buttons with tool tips to perform basic tasks.

<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image]</td>
<td>View details of the trap selected from All Traps window.</td>
</tr>
<tr>
<td>![Image]</td>
<td>Configure and manage Trap Categories</td>
</tr>
<tr>
<td>![Image]</td>
<td>Configure Alerts and Alert actions.</td>
</tr>
<tr>
<td>![Image]</td>
<td>Configure and manage filters.</td>
</tr>
<tr>
<td>![Image]</td>
<td>Generate consolidated reports by setting a wide range of parameters like Time Range, Categories, and VarBinds match.</td>
</tr>
</tbody>
</table>
All Traps Window
Displays all traps received by the TrapTracker Receiver. It can be resized, dragged and tiled vertically or horizontally. The maximum window view limit is 1000 and can be configured to display traps within this limit.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/ Time</td>
<td>Date and Time of the trap received by the TTW Receiver.</td>
</tr>
<tr>
<td>Source</td>
<td>Source from where the traps originated.</td>
</tr>
<tr>
<td>Trap Name</td>
<td>Name of the trap.</td>
</tr>
<tr>
<td>Variables</td>
<td>Variable definitions defined in the MIBs.</td>
</tr>
</tbody>
</table>

Status Bar
Displays the window view limit, serial number of the trap selected when a single trap is selected, or serial number of the last trap selected when multiple traps are selected and the total number of traps displayed currently in the window.

Systems Window
Displays the name of all monitored SNMP compliant devices.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Name</td>
<td>Name and domain of the SNMP compliant device.</td>
</tr>
<tr>
<td>IP Address</td>
<td>IP address of the device</td>
</tr>
<tr>
<td>Critical</td>
<td>Count of Critical severity traps</td>
</tr>
<tr>
<td>Warning</td>
<td>Count of Warning severity traps</td>
</tr>
<tr>
<td>Major</td>
<td>Count of Major severity traps</td>
</tr>
<tr>
<td>Information</td>
<td>Count of Information traps</td>
</tr>
<tr>
<td>Minor</td>
<td>Count of Minor severity traps</td>
</tr>
<tr>
<td>Clear</td>
<td>Count of Clear severity traps</td>
</tr>
</tbody>
</table>

Status Bar
The first section displays the trap criticality legend. The second section displays the total number of systems being monitored, total number of traps received from the monitored systems and the rate at which the traps are received.
Working with Trap Windows

TrapTracker provides an option to open up multiple trap windows, with each window displaying only traps that satisfy its selection criteria. This feature is useful in viewing the trap activity of certain devices in isolation from the rest of the enterprise.

Creating a New Trap Window

This option enables you to create a new trap window.

To create a new trap window

1. Open the TrapTracker Manager console.
2. From the File menu, choose New Window.
   (OR)
   Press Ctrl + N on your keyboard.
   (OR)
   From the Windows menu, choose New Window.

TrapTracker displays the “Select Window Parameters” window.
Figure 4 Select Window Parameters dialog box

Table 6

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Window Name</strong></td>
<td>Type a descriptive name of the window.</td>
</tr>
</tbody>
</table>
| **View By Trap Category** | This option is selected by default.  
Select a pre-defined Category or user-defined category from the “Select A Trap category” drop-down list.  
By default, the drop-down list has the following values -All-, sysStartup Events, linkUp, linkDown.  
The list gets populated along with the pre-defined Categories when you create new Categories. |
| **Source (Name/IP)**   | Type the name or IP address of the source of traps.  
You can explicitly define the Name/IP address of SNMP compliant devices and monitor traps sent only by those devices. |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Severity</td>
<td>Select a severity level of traps. Available options are -All-, Clear, Minor, Information, Major, Warning, and Critical.</td>
</tr>
<tr>
<td>Generic</td>
<td>This drop-down list is populated with pre-defined generic traps, which are common to all the SNMP compliant devices. The generic traps are as follows: -All-, coldStart, warmStart, linkDown, linkUp, authenticationFailure, egpNeighborLoss, and enterpriseSpecific. EnterpriseSpecific are vendor-specific traps, which are defined by the vendors so that their devices can meet their special management needs. coldStart - the sender is reinitializing and its configuration may change warmStart - the sender is reinitializing but its configuration will not change linkDown - failure in one of the agent's links linkUp - one of the agent's links is up authenticationFailure - the agent received an improperly authenticated protocol message authenticated egpNeighborLoss - an Exterior Gateway Protocol neighbor is down enterpriseSpecific - The trap is identified as not being one of the a basic one</td>
</tr>
<tr>
<td>Enterprise</td>
<td>This option is enabled only when you choose the &quot;enterpriseSpecific&quot; option in the “Generic” drop-down list. This list box is populated with the available compiled MIBs.</td>
</tr>
<tr>
<td>Traps</td>
<td>This list box is populated with the traps that are available in the enterprise MIB you have chosen.</td>
</tr>
<tr>
<td>Match in VarBinds</td>
<td>To further narrow down your selection criteria, you can type a variable in this field. The new window you create will display the traps that match the variable you have typed.</td>
</tr>
</tbody>
</table>

3 Select/enter appropriately in the relevant fields.
TrapTracker displays the trap details for the aforementioned selection criteria in a new window.
Renaming a Trap Window

This option enables you to rename a trap window.

To rename a trap window

1. Click the window that you want to rename.
2. From the Edit menu, choose Rename Window.

**Note**

This option is available for All Traps window, Systems window, and user-defined windows.

TrapTracker displays the "TrapTracker" dialog box.
3 Type an appropriate name in the **Enter New Name** field.
4 Click **OK**.
   (OR)
   Right-click any row on the window that you want to rename.

**Note**

This option is available only for **All Traps** window & user-defined windows and not for **Systems** window.

TrapTracker displays the shortcut menu.
From the shortcut menu, choose **Window Properties**.
(OR)
From the **View** menu, choose **Window Properties**.

**Note**

This option is available only for **All Traps** window & user-defined windows and not for **Systems** window.

TrapTracker displays the "Window Parameters" window.
Type an appropriate name in the **Window Name** field and then click **OK**.

**Note**

In **Window Parameters** dialog box, only the **Window Name** field is editable. The remaining fields are disabled and non-editable.

### Cascading Trap Windows

This option enables you to cascade all trap windows.

**To cascade trap windows**

- From the **Window** menu, choose **Cascade**.

  TrapTracker displays the cascaded trap windows.
Tile Trap Windows Horizontally

This option enables you to tile trap windows horizontally.

Tile trap windows horizontally

- From the Window menu, choose Tile Horizontal.

TrapTracker displays the trap windows tiled horizontally.
Tile Trap Windows Vertically

This option enables you to tile trap windows vertically.

Tile trap windows vertically

- From the Window menu, choose Tile Vertical.

  TrapTracker displays traps windows tiled vertically.
**Closing a Single Trap Window**

This option enables you to close a single trap window.

**To close a single trap window**

1. Click the window that you want to close.
2. From the **Window** menu, choose **Close**.

TrapTracker closes the selected window gracefully.

**Note**

TrapTracker minimizes, when you try to close the **Systems** window.

---

**Closing All Trap Windows**

This option enables you to close all trap windows.
To close all windows
- From the **Window** menu, choose **Close All**.
  
  TrapTracker closes all windows except the **Systems** window.

---

**Viewing Window Properties**

This option enables you to view properties of a selected window

To view properties of a selected window

1. Click the window that you want to view properties.
2. From the **View** menu, choose **Window Properties**.
   (OR)
   
   Right-click a trap detail record on the All Traps window or the new trap window created by you.
   
   TrapTracker displays the shortcut menu.
   
   From the shortcut menu, choose **Window Properties**.
   
   TrapTracker displays the “Window Parameters” window.
Figure 12 Trap window parameters dialog box.

Only the Window Name field is editable, while the remaining fields are disabled.

**Note**

You cannot view properties of the Systems window. When you choose Systems window to view properties, TrapTracker disables the **Trap Details** command button on the toolbar, and **Window Properties** command on the **View** menu.

---

**View All Trap Details in the Notepad**

This option enables you to view all trap details in the Notepad.

**To view all trap details (Print Preview)**

1. Click the **All Traps** window or any other trap window you have created.
2 From the **File** menu, choose **Print Preview**.

(OR)

Press the shortcut keys **CTRL+P** on your keyboard.

TrapTracker displays the trap details in the Notepad.

You can print the trap details by selecting appropriate commands in the Notepad.

You cannot view the print preview when you choose the **Systems** window. TrapTracker disables **Print Preview** command on the **File** menu.

---

**View All Trap Details in a Window**

This option enables you to view trap details in a window.

To view trap details:

1. Click the **All Traps** window or any other trap window that you have created.
2. Right-click any row that you want to view details.
TrapTracker displays the shortcut menu.
From the shortcut menu, choose **Trap Details**.

You can also view the trap details by choosing **Trap Details** from the **View** menu.

(OR)
Click **on the toolbar.

(OR)
Double-click the row that you want to view details.

TrapTracker displays the “Trap Detail” window.

![Trap Detail](image)

Table 7

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Date &amp; Time</strong></td>
<td>Date and time when the TTW Manager received the trap.</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>Name and domain of the SNMP complaint device.</td>
</tr>
<tr>
<td><strong>IP Address</strong></td>
<td>IP address of the SNMP complaint device.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Severity | Severity level of the trap.
Generic | Category type that the trap belongs to.
Enterprise | Object Id
Trap Name | Name of the trap.
VarBinds | Variables associated with the trap.
More Information | Nature of the trap. Details like when it was triggered and to which server it was sent are displayed.
User Notes | These notes are useful to keep track of what action was taken for a trap, before it is acknowledged (cleared from view and committed to the database). The notes entered are also visible in the reports / history.

4 Click `< Previous` to view trap details of the previous trap from the current position on the trap window.

5 Click `Next >` to view trap details of the next trap from the current position on the trap window.

---

**View Trap Details of a Selected System**

This option enables you to view trap details of the selected system.

**To view trap details of the selected system**

1 Right-click a row on the **Systems** window that represents the system details. TrapTracker displays the shortcut menu.

   From the shortcut menu, choose **View Traps For ‘webdoc1.Toons.local’**.

   **Note**

   ‘webdoc1.Toons.local’ is the system name and the domain where it resides. The name and the domain vary according to your selection.

   TrapTracker displays the traps sent by the selected system in a pop-up window (**Traps On ‘webdoc1.toons.local’**).
2 Double-click the trap that you want to view details.

TrapTracker displays the trap details of that particular trap.
Clearing/Acknowledging Trap Details

While monitoring traps from the centralized console, traps that have already been viewed and acted upon can be acknowledged. On acknowledging, traps are just removed from the view and are not deleted or purged from the database. This feature ensures that only new traps received by the TTW Manager are displayed on the console.

**Clear/Acknowledge a single trap**

This option enables you to clear/acknowledge a single trap.

**To clear/acknowledge a single trap**

- Right-click the trap that you want to acknowledge on the All Traps window or on the custom trap window.

  TrapTracker displays the shortcut menu.

  From the shortcut menu, choose **Clear / Acknowledge Trap(s)**.

  (OR)

  From the **Edit** menu, choose **Clear/Acknowledge Trap(s)**.

  TrapTracker clears the selected trap from view.

**Clear/Acknowledge Multiple Traps**

This option enables you to clear/acknowledge a group of traps.
To clear/acknowledge a group of traps

1. Select a trap on the All Traps window or on the custom trap window you have created.

2. Hold the **SHIFT** key and point the mouse pointer to the trap until it reaches the group you want to clear/acknowledge.

3. Right-click any selected row.
   
   TrapTracker displays the shortcut menu.
   
   From the shortcut menu, choose **Clear / Acknowledge Trap(s)**.
   
   (OR)
   
   From the **Edit** menu, choose **Clear/Acknowledge Trap(s)**.
   
   TrapTracker clears the selected trap from view.

Clear/Acknowledge All Traps of a Selected System

This option enables you to clear/acknowledge traps of a selected system.

To clear/acknowledge all traps of a selected system

- Right-click the system that you want to clear from the **Systems** window.

  TrapTracker displays the shortcut menu.

  From the shortcut menu, choose **Clear / Acknowledge Trap(s) For 'gjoe.Toons.local'**.

  TrapTracker clears all traps of the selected system.

**Auto Scroll**

Auto Scroll is an option that intimates you the arrival of a new trap. Suppose you are browsing through the All Traps window and have selected the first trap record to view its details, you will never come to know that a new trap has arrived unless you scroll down to the last record. But, by selecting Auto Scroll option, TrapTracker turns its focus on the new trap, scrolls down and highlights it.

**Viewing New Trap**

This option enables you to view new trap.
Adding a New System

When you install a new SNMP compliant device in your enterprise, you will be prompted to enter the name or IP address of the Manager that receives traps sent by SNMP compliant device you have installed. Enter appropriate details. No further configuration is needed. TTW Manager listens at port 162 for incoming traps.
Upgrading License

This option enables you to upgrade your license from trial version to registered version.

To upgrade license

1. Open the TrapTracker Manager console.
2. From the Help menu, choose Upgrade License.
   TrapTracker displays the “Upgrade License” dialog box.

   ![Upgrade License dialog box](image)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type your name.</td>
</tr>
<tr>
<td>Email</td>
<td>Type your e-mail address.</td>
</tr>
<tr>
<td>Key</td>
<td>Type the license key. Since the license key is case-sensitive, care should be taken while entering the key.</td>
</tr>
</tbody>
</table>

3. Click OK.
   On successful acceptance of the license details, TrapTracker displays the TrapTracker confirmation message box.

   ![Table 8](image)
Exiting TrapTracker

This option enables you to exit TrapTracker gracefully.

To exit TrapTracker

1. From the File menu, choose Exit.
   (OR)
   Click at the upper-right corner of the TrapTracker Manager console.
   TrapTracker displays the confirmation message box.

2. Click Yes to acknowledge all traps and exit.
3. Click No to exit without acknowledging the traps.
In this chapter, you will learn how to:

- Auto-Acknowledge traps
- Filter Traps
- Configure Alerts
Auto-Acknowledge Traps

This option enables you to acknowledge traps older than a specific period of time, set window view limit, and purge traps from the database.

To auto-acknowledge traps

- From the Options menu, choose Configuration.

  TrapTracker displays the "Configuration" window.

Figure 22
Configuration dialog box

Table 9

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledge traps older than</td>
<td>Select an option from the drop-down list. Traps are cleared /acknowledged that are older that specified period of time.</td>
</tr>
<tr>
<td>View maximum</td>
<td>Set the number of traps that you want to view in a window.</td>
</tr>
<tr>
<td>Purge all traps older than</td>
<td>Select the number of days. TrapTracker deletes traps permanently from the database after the specified number of days.</td>
</tr>
</tbody>
</table>
Filtering Traps from View

You can filter traps of minor significance from the view. They are not purged from the database but are logged into the database and available for reports and history views.

Adding Trap Filter

This option enables you to add a trap filter.

To add a trap filter
1. From the Options menu, choose Filters.
   (OR)
   Click Filters on the toolbar.
   TrapTracker displays the “Filter Traps” console.
Click **Add Filter**.

TrapTracker displays the “Trap Filter” window.

![Filter Traps dialog box](image)

**Table 10**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source (Name/IP)</td>
<td>Type the name or IP address of the source of traps that you want to filter out.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generic</td>
<td>This drop-down list is populated with pre-defined generic traps, which are common to all SNMP-compliant devices.</td>
</tr>
<tr>
<td>Enterprise</td>
<td>This option is enabled only when you choose the enterpriseSpecific option in the Generic drop-down list. This list box is populated with the available compiled MIBs.</td>
</tr>
<tr>
<td>Traps</td>
<td>This is a list box, which is populated with the traps that are available in the enterprise MIB you have chosen.</td>
</tr>
<tr>
<td>Match in Varbinds</td>
<td>To further narrow down your selection criteria, you can enter a variable in this field. The new window you create will display the traps that match the variable you have entered.</td>
</tr>
</tbody>
</table>

3. Select/enter appropriately in the relevant fields.

4. Click OK.

   TrapTracker adds the newly created trap filter to the Filter Traps pool.
To modify the trap filter

1. From the Options menu, choose Filters.
   
   (OR)

   Click Filters on the toolbar.

   TrapTracker displays the "Filter Traps" console.
2 Select the filter that you want to modify.

3 Click **Edit Filter**.

   TrapTracker displays the “Trap Filter” window with the configuration details.

4 Select/enter appropriately and then click **OK**.

5 Click **Cancel** to retain the previous settings.

6 Click **Close** on the “Filter Traps” console.
Deleting Trap Filter
This option enables you to delete the trap filter.

To delete trap filter
1 From the Options menu, choose Filters.
   (OR)
   Click Filters on the toolbar.
   TrapTracker displays the “Filter Traps” console.

2 Select the filter that you want to delete.
3 Click Remove Filter.
   TrapTracker displays the confirmation message box.
Click Yes to remove or No to retain.

5 Click Close.

Alerts

TrapTracker Manager provides an option to notify the user when traps matching the criteria set are received by the TTW Receiver.

You can associate Alert actions to the Alert configuration. Alert notification mechanisms available are, a beep on the system hosting the TrapTracker Manager, an e-mail to a specified e-mail id, a console message to a specified system, and a custom action like running an EXE or .a BAT job.

A typical example would be the Routers, which are critical to every enterprise. Alerts can be configured to notify the user when the monitored routers’ normal functionality goes down.

Adding Alerts

This option enables you to configure Alerts

To configure Alerts

1 From the Options menu, choose Alerts.

(OR)

Click Alerts on the toolbar.

TrapTracker displays the “Alerts” console.
2 Click **Add**.

TrapTracker displays "Alert Configuration" window.
### Table 11

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert Description</td>
<td>Type a brief description about the Alert.</td>
</tr>
<tr>
<td>Trap Details</td>
<td></td>
</tr>
<tr>
<td>Source (Name/IP)</td>
<td>Name or IP address of the source of traps. You can explicitly define the Name/IP address of SNMP compliant devices and monitor traps sent only by those devices.</td>
</tr>
<tr>
<td>Generic</td>
<td>This drop-down list is populated with pre-defined generic traps, which are common to all the SNMP compliant devices.</td>
</tr>
<tr>
<td>Enterprise</td>
<td>This option is enabled only when you choose the enterpriseSpecific option in the Generic drop-down list. This list box is populated with the available compiled MIBs.</td>
</tr>
<tr>
<td>Traps</td>
<td>This is a list box, which is populated with the traps that are available in the enterprise MIB you have chosen.</td>
</tr>
<tr>
<td>Match in VarBinds</td>
<td>To further narrow down your selection criteria, you can enter a variable in this field. The new window you create will display the traps that match the variable you have entered.</td>
</tr>
<tr>
<td>Actions</td>
<td></td>
</tr>
<tr>
<td>Beep</td>
<td>A beep is heard when the TrapTracker Manager receives the specific configured trap.</td>
</tr>
<tr>
<td>Email</td>
<td>An e-mail is sent to the configured recipient address when the Manager receives the specific configured trap.</td>
</tr>
<tr>
<td>Message</td>
<td>A network message is sent to the console of the configured system when the Manager receives the specific configured trap.</td>
</tr>
</tbody>
</table>
**Chapter 2: Managing Traps**

### Custom

Certain situations may arise when the administrator needs to perform some customized action on receiving a trap. In this case, the recommended practice is to create a batch file or program and select that batch file or program in the Custom Action screen. On receiving a matching trap, the Manager will execute the batch file or program file selected, and will pass the following as parameters to the batch file or program. The order of parameters is also the same as below.

- **IP Address**
- **Enterprise OID**
- **Community**
- **Generic Trap ID**
- **Specific Trap ID**

A recommended method to write a custom program is to print the received parameters and then build the program. This enables the user to understand the way the parameters are being passed to the program.

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
</table>
| **Custom** | Certain situations may arise when the administrator needs to perform some customized action on receiving a trap. In this case, the recommended practice is to create a batch file or program and select that batch file or program in the Custom Action screen. On receiving a matching trap, the Manager will execute the batch file or program file selected, and will pass the following as parameters to the batch file or program. The order of parameters is also the same as below.  
- **IP Address**  
- **Enterprise OID**  
- **Community**  
- **Generic Trap ID**  
- **Specific Trap ID**  
A recommended method to write a custom program is to print the received parameters and then build the program. This enables the user to understand the way the parameters are being passed to the program. |
| **Edit** | Edit the previously configured alert notification mechanism. |

### Configuring Audible Alert action

This option enables you to configure audible Alert action.

**To configure audible Alert action**

1. Select/enter appropriate trap details in the “Alert Configuration” window.
2 Select the **Beep** check box

TrapTracker displays the “Configure Action – Beep” window.

### Alert Configuration

- **Alert Description:** AudibleAlert
- **Source IP Address:** webdoc1.toons.local
- **Generic:** enterpriseSpecific
- **Enterprise:** pmiSystem
- **Traps:** pmiAppUsageTrap, pmiEventTrap, pmiSubTrap
- **Match In VarBinds:** evtLogType=2

### Configure Action

- **Description:** Default
- **Beep Count:** 1
- **Duration:** 1
- **Delay:** 0
- **Frequency:** 1000

### Table 12

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beep Configuration</td>
<td></td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Type a brief Alert description.</td>
</tr>
<tr>
<td>Beep Count</td>
<td>Type the number of beeps that should be generated on the PC speaker.</td>
</tr>
<tr>
<td></td>
<td>This field supports numeric datatype only.</td>
</tr>
<tr>
<td>Duration</td>
<td>Type how long the beep should be sustained.</td>
</tr>
<tr>
<td></td>
<td>This field supports numeric datatype only.</td>
</tr>
<tr>
<td>Delay</td>
<td>Type the time interval to pause between consecutive beeps.</td>
</tr>
<tr>
<td></td>
<td>This field supports numeric datatype only.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Type the frequency of the beep in Hertz.</td>
</tr>
<tr>
<td></td>
<td>This field supports numeric datatype only.</td>
</tr>
</tbody>
</table>

3 Type appropriately in the relevant fields and then click **OK**.

4 Click **OK** on the "Alert Configuration" window.

TrapTracker displays the “Alerts” console with the newly created audible Alert.

5 Click **Close**.
Configuring E-mail Alert action

This option enables you to configure e-mail Alert action.

To configure e-mail Alert action

1. Select/enter appropriate Trap Details in the "Alert Configuration" window.

2. Select the Email check box.

   TrapTracker displays the "Configure Action – Email" window.
Field | Description
---|---
Email Configuration
To | Type a valid recipient e-mail address.
Subject | Subject of the e-mail.
From | Type a valid sender e-mail address.
SMTP Server | Type the SMTP Server name or IP address or select it from the drop-down list.

3. Select/enter appropriately in the relevant fields and then click **OK**.

4. Click **OK** on the “Alert Configuration” window.

TrapTracker displays the “Alerts” console with the newly created e-mail Alert.
CHAPTER 2
MANAGING TRAPS

1B

Click Close.

Configuring Console Message Alert action
This option enables you to configure console message Alert action.

To configure console message Alert action

Note

Messenger service must be available to configure this action.

1 Select/enter appropriate Trap Details in the “Alert Configuration” window.
Select the **Message** check box. TrapTracker displays the “Configure Action – Message” window.

```
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Figure 39 Alert Configuration dialog box – set up console message alert.

Figure 40 Configure Action dialog box.
Field Description

Message Configuration: A notification message will be sent to the machine of your choice.

Type the name or IP address of the machine or you can select from the drop-down list.

3 Type appropriately in the relevant fields and then click OK.

4 Click OK on the “Alert Configuration” window.

TrapTracker displays the Alerts console with the newly created console message Alert.

5 Click Close.

Executing Custom Alert action

This option enables you to set up a custom Alert action.

To execute custom Alert action

1 Select/enter appropriate Trap Details in the “Alert Configuration” window.
2 Select the **Custom** check box.

TrapTracker displays the “Configure Action – Custom” window.

![Configure Action dialog box](image)

Table 15

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>

Figure 42 Alert Configuration dialog box – set up custom action alert.

Figure 43 Configure Action dialog box.
**CHAPTER 2**

**MANAGING TRAPS**

---

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Configuration: Select a file to be executed when a specific trap occurs.</td>
<td>Select a file from the drop-down list or click <strong>Browse</strong> to browse for the file.</td>
</tr>
</tbody>
</table>

3. **Click Browse.**

TrapTracker displays the “Open” window.

![Figure 44 Open dialog box.](image)

4. **Select a custom file and then click **Open**.**

TrapTracker updates the Configure Action window with the path of the custom file.
5 Click OK.

6 Click OK on the "Alert Configuration" window. TrapTracker displays the Alerts console with the newly created custom Alert.

7 Click Close.

Modifying Alert Configuration Details

This option enables you to modify Alert and Alert action configuration settings.
To modify Alert and Alert action configuration

1. From the **Options** menu, choose **Alerts**.

   (OR)

   Click **Alerts** on the toolbar.

   TrapTracker displays the “Alerts” console.

   ![Alerts dialog box](image1)

2. Select the Alert that you want to modify.

   ![Alerts dialog box](image2)
3 Click **Edit**.

TrapTracker displays "Alert Configuration" window with the configuration settings set earlier.

![Alert Configuration dialog box.](image)

4 Select/enter appropriately in the relevant fields under Trap Details.

5 Click **Edit** to modify the Alert actions.

TrapTracker displays "Configure Action – Custom" window.
6 Click **Browse** to select a custom file from “Open” window.

7 Select a file that you want to execute and click **Open**.

   TrapTracker updates the “Configure Action – Custom” window with the path of the new file chosen.

8 Click **OK**.

9 Click **OK** on the “Alerts Configuration” window.

10 Click **Close**.
Deleting Alert Configuration Details

This option enables you to delete Alert configuration settings.

To delete Alert configuration setting

1. From the Options menu, choose Alerts.
   (OR)
   Click Alerts on the toolbar.
2. Select the Alert that you want to delete.
3. Click Remove.
   TrapTracker displays the confirmation message box.
4. Click Yes to delete or No to retain.
5. Click Close.
Chapter 3
Reports & Categories

In this chapter, you will learn how to:

- Create Categories
- Modify Categories
- Delete Categories
- Add Trap Details to a Category
- Modify Trap Details in a Category
- Delete Trap Details from a Category
- Export Category
- Import Category
- Generate Historical Reports
Managing Trap Categories

TrapTracker has categories feature, where a set of related traps are grouped together as your needs dictate into a category. Whenever a trap in a category occurs, the Reports will highlight that category with an appropriate trap severity indicator. This feature enables easy identification of critical traps that are generated by a device that belongs to a specific category.

The steps involved in using categories are:

1. Creating a Category
2. Adding traps to that Category
3. Defining the Trap Severity for each trap added
4. Monitoring the status of the Category by running Reports

Example:

Take the case of a category that monitors all critical traps generated from a Router. This category will contain all the important traps that are generated by the router. Each trap will have its own severity level. When the user monitors the status of this category using the Reports console, the category will be highlighted with the color code of the trap with the maximum severity that has been generated by the router.

If the category contains 2 traps,

1. First trap with Trap ID = 1.3.6.1.4.1.618, Source = 192.244.88.11, Severity=Major
2. Second trap with Trap ID = 1.3.6.8.4.1.724, Source = 192.244.88.11, Severity=Critical

If the device (192.244.88.11) had generated a trap with trap ID = 1.3.6.1.4.1.618, then the Reports would indicate the presence of a Major Severity trap in the device (192.244.88.11).

If the device (192.244.88.11) had generated a trap with trap ID = 1.3.6.1.4.1.618 and another trap with trap ID = 1.3.6.8.4.1.724, then the Reports would indicate the presence of a Critical Severity trap from device 192.244.88.11.

Therefore, the most significant severity level takes precedence over its peers.

If either of these two traps were not generated, then the Reports would make no indication for this category.

Creating Trap Category

This option enables you to create a trap category.
To create a trap category

1. From the Reports menu, choose Categories.
   (OR)
   Click Trap Categories on the toolbar.
   TrapTracker displays the “Manage Categories” console.

2. Click Create Category.
   TrapTracker displays the “Add Category” window.

Pre-defined categories are linkDown, linkUp and sysStartup Events.

Table 16

<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Category</td>
<td>Create a category.</td>
</tr>
<tr>
<td>Delete Category</td>
<td>Delete a category.</td>
</tr>
<tr>
<td>Edit Category</td>
<td>Modify category details.</td>
</tr>
<tr>
<td>Add Traps</td>
<td>Add trap details to a category.</td>
</tr>
<tr>
<td>Remove Traps</td>
<td>Delete traps details from a category.</td>
</tr>
<tr>
<td>Edit Trap</td>
<td>Modify trap details in a category.</td>
</tr>
</tbody>
</table>

Note

Pre-defined categories are linkDown, linkUp and sysStartup Events.
3 Type an appropriate name in the **Trap Category Name** field. This field is mandatory. If you skip this, TrapTracker displays the TrapTracker message box with appropriate message.

4 Type a brief description of the Category in the **Description** field. This field is not mandatory.
5 Click **Next >** to add trap details.

TrapTracker displays the “Add Trap Detail” window.
TRAP TRACKER VER. 4.0 USER GUIDE

CHAPTER 3

REPORTS & CATEGORIES

Figure 57 Add Trap Detail dialog box.

Table 17

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Severity</td>
<td>Select a severity level from this drop-down list. Available options are -All-, Clear, Minor, Information, Major, Warning, and Critical.</td>
</tr>
<tr>
<td>Source (Name/IP)</td>
<td>Type the name or IP address of the source of traps.</td>
</tr>
<tr>
<td>Generic</td>
<td>This drop-down list is populated with pre-defined generic traps, which are common to all SNMP compliant devices.</td>
</tr>
<tr>
<td>Enterprise</td>
<td>This option is enabled only when you choose the enterpriseSpecific option in the Generic drop-down list. This list box is populated with the available compiled MIBs.</td>
</tr>
<tr>
<td>Traps</td>
<td>This list box is populated with the traps that are available in the enterprise MIB you have chosen.</td>
</tr>
<tr>
<td>Match in Varbinds</td>
<td>To further narrow down your selection criteria, you can enter the variables associated with the chosen MIB, in this field.</td>
</tr>
<tr>
<td>Trap Description</td>
<td>The trap description defined in the MIB is displayed in this display box.</td>
</tr>
</tbody>
</table>
Select/enter appropriately in the relevant fields.

Click **Add** to add trap details.

Had you selected the default severity level, TrapTracker displays the TrapTracker message box with appropriate message.

Click **Add** to add trap details.

Choose a severity level other than the default value and click **Add**. This way you can add n number of trap details to your category.

Click **Finish** to save the category details.
If you click **Finish** without adding trap details, TrapTracker displays the TrapTracker message box with appropriate message.

![TrapTracker message box](image1)

11. If you click **Yes**, the category is created without any trap details. Later, you can add trap details to this category.

   TrapTracker displays the “Manage Categories” console with the newly created category.

![Manage Categories dialog box](image2)

12. Click **OK**.

### Monitoring Custom Categories

To monitor custom categories

1. From **Reports** menu, choose **Report/History**.

   (OR)

   Click ![Report](image3) on the toolbar.

   TrapTracker displays the “Select Report / History Parameters” window.
2 Type the name of the window in the **Window Name** field.
3 Select **From**, **To** Date and Time.
4 Select the **View By Trap Category** option.
5 Select the category from the **Select A Trap Category** drop-down list.
Click **OK**.

TrapTracker displays the trap details of the selected category in a new window.
Modifying Category Details

This option enables you to modify category details.

To modify category details

1. From the Reports menu, choose Categories.
   (OR)
   Click Trap Categories on the toolbar.

2. On the left pane, select the category that you want to modify and then click Edit Category.
   (OR)
   Double-click the category that you want to modify.
   TrapTracker displays the “Edit Category” window.

---

7. Close the window by clicking \( \times \) at the upper-right corner of the window.
You can edit Description alone and not the Trap Category Name.

Click Finish.

Click Cancel to retain the previous configuration settings.

Click OK.

---

**Deleting Category**

This option enables you to delete a category.

To remove a category

1. From the Reports menu, choose Categories.
   
   (OR)
   
   Click Trap Categories on the toolbar.

2. On the left pane, select the category that you want to delete.

3. Click **Delete Category**.

   TrapTracker displays the confirmation message box.
Adding Trap Details to a Trap Category

This option enables you to add trap details to a trap Category.

To add trap details to a trap Category

1. From the Reports menu, choose Categories.
   (OR)
   Click Trap Categories on the toolbar.
2. On the left pane, select a category.
3. Click Add Traps.
   TrapTracker displays the “Add Trap Detail” window.

4. Click Yes to delete the selected category or No to retain.
5. Click OK.
4 Select/enter appropriately in the relevant fields.
5 Click **Add** and then click **Finish**.

TrapTracker displays the "Manage Categories" console with the newly added trap details.

---

**Figure 68 Add Trap Detail dialog box**

**Figure 69 Manage Categories dialog box with newly added trap details.**
6 Click **OK**.

If you click **Cancel**, TrapTracker displays the TrapTracker message box with appropriate message.

![TrapTracker message box.](image)

7 Click **Yes** to save the changes and exit or click **No** to exit without saving.

8 Click **Cancel** and then click **OK** on the Manage Categories console.

---

**Modifying Trap Details in a Trap Category**

This option enables you to modify trap details in a trap category.

To modify trap details in a trap category

1 From the **Reports** menu, choose **Categories**.

   (OR)

   Click **Trap Categories** on the toolbar.

2 On the left pane, select the category.

![Manage Categories window.](image)
On the right pane, double-click the trap detail you want to modify. (OR) Select the trap detail on the right pane and then click **Edit Trap**. TrapTracker displays "Edit Trap Detail" window.

3 Select/enter appropriately in the relevant fields and click **Finish**.

4 Click **OK**.

**Deleting Trap Details from a Trap Category**

This option enables you to delete trap details from a trap Category.

To delete trap details from a trap category

1 From the **Reports** menu, choose **Categories**.

(OR) Click **Trap Categories** on the toolbar.
On the left pane, select the Category.

On the right pane, select the trap detail you want to delete.

Click **Remove Trap**.

TrapTracker displays the confirmation message box.

Click **Yes** to delete the selected category or **No** to retain.

Click **OK**.

---

**Import and Export Trap Categories**

The category import and export feature is provided to ease the category creation process and to help in category redistribution. Categories can be exported to a file and these files can be imported by any other systems in an enterprise. This concept is concerned with creating categories in a system and utilizing them on any other systems in an enterprise that may need it.

---

**Exporting Trap Categories**

This option enables you to export a trap Category.

To export a trap category

1. From the **Reports** menu, choose **Export Categories**.

TrapTracker displays the “Export Categories” window.
TrapTracker displays all available pre-defined and user-defined categories.

2 Select a single category or hold Shift key and select multiple categories and then click Export.

TrapTracker displays the “Select Export File” window.

![Export Categories dialog box](image1)

![Select Export File dialog box](image2)

**Note**

The file extension of the export file is .iscat.
3 Go to the directory where you want to save the export file.
4 Type a name in the **File name** field.
5 Click **Save**.
   TrapTracker displays the TrapTracker message box with appropriate status of the export.
6 Click **OK**.
7 Click **Close** on the “Export Categories” window.

### Importing Trap Categories

This option enables you to import a trap category.

**To import a trap category**

1 From the **Reports** menu, choose **Import Categories**.
   TrapTracker displays “Select Import File” window.
Go to the directory where you have stored the category file.

3. Select the file and then click **Open**.

    TrapTracker displays TrapTracker message box with appropriate status of the import.

4. Click **OK**.

5. From the **Reports** menu, choose **Categories** to view the imported categories.

---

**Reports**

The Reports feature presents a very simplified picture of all the trap activities in your enterprise or any specific device. This feature is designed to help you obtain a high-level perspective about the health of a critical device. Using a combination of pre-defined categories and user-defined categories, the Reports feature provides you a quick insight into the trap activities that have occurred in a specific time frame.
User-defined categories are populated in the Select a Trap Category list box in the Select / History Parameters dialog box. Using a combination of Alerts, Categories and Reports, you can easily isolate the devices and resolve issues.

Reports present the data in two formats:

1. Based on categories.
2. Based on custom trap selection criteria.

---

**Generating Reports**

This option enables you to generate reports.

**To generate reports**

1. From the Reports menu, choose Report/History.

   (OR)

   Click the Report on the toolbar.

   TrapTracker displays “Select Report / History Parameters” window.
2 Type the window name in the **Window Name** field.
3 Select the **From** and **To** date and time.

**VIEW TRAP BY TRAP CATEGORY**
This option enables you to view traps by trap category.

To view trap by Trap Category
1 Select the **View By Trap Category** option.
2 Select a category from the **Select A Trap Category** drop-down list.
3 Click **OK**.

TrapTracker displays the trap details of the selected category in a new window.
CHAPTER 3
REPORTS & CATEGORIES

TRAPTRACKER VER. 4.0 USER GUIDE

Reports

Double-click a trap to view details.

Click at the upper-right corner of the “Reports / History (evtTicks Cat)” window to close.

VIEW TRAP BY CUSTOM SELECTION
This option enables you to view traps by custom selection.

To view trap by custom selection

Select the View By Custom Selection option.
2 Type the name of IP address of the source in the **Source [Name / IP]** field.

3 Select the severity level from the **Severity** drop-down list.

4 Select the generic trap type from the **Generic** drop-down list.

**Note**

The **Enterprise** list box is enabled, only when you choose **enterpriseSpecific** trap type from the **Generic** drop-down list.

5 Select the enterprise from the **Enterprise** drop-down list.

6 Select the traps associated with the selected enterprise from the **Traps** drop-down list.
7 Type the varBinds associated with the selected trap in the **Match In VarBinds** field.

![Select Report / History Parameters dialog box with user entered values.]

8 Click **OK**.

TrapTracker displays the trap details of the selected category in a new window.
Double-click the trap record to view details. TrapTracker displays the trap details in the “Trap Detail” window.
Type notes in the **User Notes** field and then click **OK**.

Click **Previous** to view details of the previous trap.

Click **Next** > to view the details of the next trap.

Click **X** at the upper-right corner of the Report / History (Custom View) window to close.
Chapter 4
Tools

In this chapter, you will learn about:

- SMI
- SNMP
- MIB
- MIB II Tree
- SNMP Datatypes
- UDP
- MibCompiler / Browser
- Starting MibCompiler
- Understanding MibCompiler Console
- Need for MIB Compilation
- Compiling a MIB File
- Viewing MIB Details
- Viewing Trap Details
- Search and Find
- Deleting MIB
- Exiting MibCompiler
- DB Compaction
What is SMI?

SMI stands for Structure of Managed Information and represents the notation by which an SNMP MIB must be written. Another way to look at SMI is that it is the grammar to write SNMP MIBs. There are two types of SMI: SMIv1 and SMIv2 with SMIv1 being the earlier version, of course, back in 1990.

SMIv1 is now an obsolete notation. However, there are still many SNMP MIBs written before SMIv2 arrived in 1993. SMIv1 is represented by the following IETF RFCs (Request for Comments):

- RFC 1155 for Structure and Identification of Management Information for TCP/IP-based Internets
- RFC 1212 for Concise MIB Definitions
- RFC 1215 A Convention for Defining Traps

SMIv2 is the new notation, which should be used whenever you create a new MIB. SMIv2 is represented by the following MIBs:

- RFC 2576 for Coexistence between Version 1, Version 2, and Version 3
- RFC 2578 for Structure of Management Information Version 2
- RFC 2579 for Textual Conventions for SMIv2
- RFC 2580 for Conformance Statements for SMIv2

"In order for the MIB to serve the needs of a network-management system, it must meet two objectives:

1. The object or objects used to represent a particular resource must be the same at each node. [...]  
2. A common scheme for representation must be used to support interoperability." - William Stallings.

In both Internet and OSI (Open System Interconnection) network management, these two objectives are met by a common structure of management information (SMI), which is defined in RFC 1155. The SMI is the specification for the MIB object tree, which provides a means of associating a common numerical identification code for a given object.

For more information, refer

TCP/IP MIB Objects, Object Characteristics and Object Types.

What is SNMP?

The SNMP Management Framework presently consists of five major components:

- An overall architecture, described in RFC 2571 [RFC2571].
Mechanism for describing and naming objects and events for the purpose of management. The first version of this Structure of Management Information (SMI) is called SMIv1 and is described in STD 16, RFC 1155 [RFC1155], STD 16, RFC 1212 [RFC1212] and RFC 1215 [RFC1215]. The second version called SMIv2 is described in STD 58, RFC 2578 [RFC2578], RFC 2579 [RFC2579] and RFC 2580 [RFC2580].

Message protocols for transferring management information. The first version of the SNMP message protocol is called SNMPv1 and is described in STD 15, RFC 1157 [RFC1157]. A second version of the SNMP message protocol, which is not an Internet standards track protocol is called SNMPv2c and is described in RFC 1901 [RFC1901] and RFC 1906 [RFC1906]. The third version of the message protocol is called SNMPv3 and is described in RFC 1906 [RFC1906], RFC 2572 [RFC2572] and RFC 2574 [RFC2574].

Protocol operations for accessing management information. The first set of protocol operations and associated PDU formats is described in STD 15, RFC 1157 [RFC1157]. A second set of protocol operations and associated PDU formats is described in RFC 1905 [RFC1905].

A set of fundamental applications is described in RFC 2573 [RFC2573]. The view-based access control mechanism is described in RFC 2575 [RFC2575]. A more detailed introduction to the current SNMP Management Framework can be found in RFC 2570 [RFC2570].

The Simple Network Management Protocol is a protocol for Internet network management services. It is formally specified in a series of related RFC documents. (Some of these RFCs are in "historic" or "informational" status)

- RFC 1067 - A Simple Network Management Protocol
- RFC 1089 - SNMP over Ethernet
- RFC 1140 - IAB Official Protocol Standards
- RFC 1147 - Tools for Monitoring and Debugging TCP/IP Internets and Interconnected Devices [superceded by RFC 1470]
- RFC 1155 - Structure and Identification of Management Information for TCP/IP based Internets.
- RFC 1156 (H)- Management Information Base Network Management of TCP/IP based internets
- RFC 1157 - A Simple Network Management Protocol
- RFC 1158 - Management Information Base Network Management of TCP/IP based internets: MIB-II
- RFC 1161 (H)- SNMP over OSI
- RFC 1187 - Bulk Table Retrieval with the SNMP
- RFC 1212 - Concise MIB Definitions
What is MIB?

An MIB is not a database but a file written in a specific language that lists variables. It assigns each variable a name, a number, and a set of permissions. It may also provide a description of what the variable is supposed to represent. Since everything in SNMP is a "simple" action on a variable, this is important.

The MIB files define a hierarchy. Each MIB variable is a leaf in the MIB tree. So how are names translated into numbers that the device will understand? In the MIB tree, each level is responsible for numbering itself in relation to the level above. .1.3.6.1.2.1.1.1 But that is not quite all. There can actually be many instances of the same variable on any single device, and so you must specify an instance number with any request.

To obtain values of objects from the agent, you need to specify the instance of the object. Appending an instance index to the object identifier specifies the instance of an object. For example, the last 0 in: \texttt{iso.3.dod.1.mgmt.mib.1.sysUpTime.0} is the instance index. An instance index of "0" (zero) specifies the first instance, "1" specifies the second instance, and so on. Since sysUpTime is a scalar object, it has only one instance. Therefore, an instance index of zero is always specified when retrieving the

SNMPv1 is historic and SNMPv3 is now standard and is described by RFCs 3410-3418 (note: 3410 is informational)

What do SNMPv1 and SNMPv2 have to do with SM Iv1 and SM Iv2?

SNMPv1 and SNMPv2 are transport protocols to carry MIB information, while SM Iv1 and SM Iv2 only specify the grammar by which SNMP MIBs are written. In fact, there is an SNMPv3 protocol definition, which relies on SM Iv2.
value of a scalar object. An instance index higher than 0 can only be used in the case of columnar objects (in table), which can have multiple instances.

**MIB-II Tree**

MIB variables have to be simple elements because of the purpose of the SNMP. Therefore, these variables are elementary stand-alone quantities, integers, octet strings, or object identifiers. Sometimes, these variables are organized into tables.

The tree of MIB variables does not have limits; it can grow and grow. Therefore, it is not surprising that definitions need to be improved or updated occasionally. If the improvement involves a major change, an updated version of the MIB will simply define a completely new variable and mark the old one as deprecated or outright obsolete.

Eleven groups are referenced in the original MIB-II document (RFC 1213). One of these, CMOT (ISO Common Management Information on top of TCP/IP) is no longer used because this project was abandoned. The 10 remaining groups describe the basic information required to manage a TCP/IP Internet.
Groups of MIB-II

Refer the following links for detailed information on MIB-II groups.

- **System group (1.3.6.1.2.1.1)** Defines a list of objects that pertain to system operation, such as the system uptime, system contact, and system name.

- **Interfaces group (1.3.6.1.2.1.2)** Keeps track of the status of each interface on a managed entity. The `interfaces` group monitors, which interfaces are up or down and track such things as octets sent and received errors and discards, etc.

- **Address Translation group (1.3.6.1.2.1.3)** The address translation (at) group is deprecated and is provided only for backward compatibility. It will probably be dropped from MIB-III.

- **Internet Protocol group (1.3.6.1.2.1.4)** Keeps track of many aspects of IP, including IP routing.
- Internet Control Message Protocol group (1.3.6.1.2.1.5) Tracks things such as ICMP errors, discards, etc.
- Transmission Control Protocol group (1.3.6.1.2.1.6) Tracks, among other things, the state of the TCP connection (e.g., closed, listen, synSent, etc.).
- User Datagram Protocol group (1.3.6.1.2.1.7) Tracks UDP statistics, datagrams in and out, etc.
- Exterior Gateway Protocol group (1.3.6.1.2.1.8) Tracks various statistics about EGP and keeps an EGP neighbor table.
- SNMP group (1.3.6.1.2.1.11) Measures the performance of the underlying SNMP implementation on the managed entity and tracks things such as the number of SNMP packets sent and received.
- Transmission group (1.3.6.1.2.1.10) There are currently no objects defined for this group, but other media-specific MIBs are defined using this subtree.

### SNMPv1 Datatypes

SNMP uses the following basic ASN.1 datatypes as the most important ones:

<table>
<thead>
<tr>
<th>Datatype</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTEGER</td>
<td>A 32-bit number often used to specify enumerated types within the context of a single managed object. For example, the operational status of a router interface can be up, down, or testing. With enumerated types, 1 would represent up, 2 down, and 3 testing. The value zero (0) must not be used as an enumerated type, according to RFC 1155.</td>
</tr>
<tr>
<td>OCTET STRING</td>
<td>A string of zero or more octets (more commonly known as bytes) generally used to represent text strings, but also sometimes used to represent physical addresses.</td>
</tr>
<tr>
<td>Datatype</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Counter</td>
<td>A 32-bit number with minimum value 0 and maximum value $2^{32} - 1$ (4,294,967,295). When the maximum value is reached, it wraps back to zero and starts over. It's primarily used to track information such as the number of octets sent and received on an interface or the number of errors and discards seen on an interface. A Counter is monotonically increasing, in that its values should never decrease during normal operation. When an agent is rebooted, all Counter values should be set to zero. Deltas are used to determine if anything useful can be said for successive queries of Counter values. A delta is computed by querying a Counter at least twice in a row, and taking the difference between the query results over some time interval.</td>
</tr>
<tr>
<td>OBJECT IDENTIFIER</td>
<td>A dotted-decimal string that represents a managed object within the object tree. For example, 1.3.6.1.4.1.9 represents Cisco Systems' private enterprise OID.</td>
</tr>
<tr>
<td>NULL</td>
<td>Not currently used in SNMP.</td>
</tr>
<tr>
<td>SEQUENCE</td>
<td>Defines lists that contain zero or more other ASN.1 datatypes.</td>
</tr>
<tr>
<td>SEQUENCE OF</td>
<td>Defines a managed object that is made up of a SEQUENCE of ASN.1 types.</td>
</tr>
<tr>
<td>IpAddress</td>
<td>Represents a 32-bit IPv4 address. Neither SMIv1 nor SMIv2 discusses 128-bit IPv6 addresses; this problem will be addressed by the IETF's SMI Next Generation (SMING) working group (see <a href="http://www.ietf.org/html.charters/sming-charter.html">http://www.ietf.org/html.charters/sming-charter.html</a>).</td>
</tr>
<tr>
<td>NetworkAddress</td>
<td>Same as the IpAddress type, but can represent different network address types.</td>
</tr>
<tr>
<td>Gauge</td>
<td>A 32-bit number with minimum value 0 and maximum value $2^{32} - 1$ (4,294,967,295). Unlike a Counter, a Gauge can increase and decrease at will, but it can never exceed its maximum value. The interface speed on a router is measured with a Gauge.</td>
</tr>
<tr>
<td>TimeTicks</td>
<td>A 32-bit number with minimum value 0 and maximum value $2^{32} - 1$ (4,294,967,295). TimeTicks measures time in hundredths of a second. Uptime on a device is measured using this datatype.</td>
</tr>
<tr>
<td>Opaque</td>
<td>Allows any other ASN.1 encoding to be stuffed into an OCTET STRING.</td>
</tr>
</tbody>
</table>
SNMPv2 Datatypes

SNMP uses the following basic ASN.1 datatypes as the most important ones:

<table>
<thead>
<tr>
<th>Datatype</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer32</td>
<td>Same as an INTEGER.</td>
</tr>
<tr>
<td>Counter32</td>
<td>Same as a Counter.</td>
</tr>
<tr>
<td>Gauge32</td>
<td>Same as a Gauge.</td>
</tr>
<tr>
<td>Unsigned32</td>
<td>Represents decimal values in the range of 0 to $2^{32} - 1$ inclusive.</td>
</tr>
<tr>
<td>Counter64</td>
<td>Similar to Counter32, but its maximum value is 18,446,744,073,709,551,615. Counter64 is ideal for situations in which a Counter32 may wrap back to 0 in a short amount of time.</td>
</tr>
<tr>
<td>BITS</td>
<td>An enumeration of nonnegative named bits.</td>
</tr>
</tbody>
</table>

SNMPv2 Object Definition Enhancements

<table>
<thead>
<tr>
<th>Object Definition Enhancements</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UnitsParts</td>
<td>A textual description of the units (i.e., seconds, milliseconds, etc.) used to represent the object.</td>
</tr>
<tr>
<td>MAX-ACCESS</td>
<td>An OBJECT-TYPE's ACCESS can be MAX-ACCESS in SNMPv2. The valid options for MAX-ACCESS are read-only, read-write, read-create, not accessible, and accessible-for-notify.</td>
</tr>
<tr>
<td>STATUS</td>
<td>This clause has been extended to allow the current, obsolete, and deprecated keywords. current in SNMPv2 is the same as mandatory in an SNMPv1 MIB.</td>
</tr>
<tr>
<td>AUGMENTS</td>
<td>In some cases it is useful to add a column to an existing table. The AUGMENTS clause allows you to extend a table by adding one or more columns, represented by some other object. This clause requires the name of the table the object will augment.</td>
</tr>
</tbody>
</table>
# Textual conventions for SMIv2

Table 21

<table>
<thead>
<tr>
<th>Textual Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DisplayString</td>
<td>A string of NVT ASCII characters. A DisplayString can be no more than 255 characters in length.</td>
</tr>
<tr>
<td>PhyAddress</td>
<td>A media- or physical-level address, represented as an OCTET STRING.</td>
</tr>
<tr>
<td>MacAddress</td>
<td>Defines the media-access address for IEEE 802 (the standard for local area networks) in canonical order. (In everyday language, this means the Ethernet address.) This address is represented as six octets.</td>
</tr>
<tr>
<td>TruthValue</td>
<td>Defines both true and false Boolean values.</td>
</tr>
<tr>
<td>TestAndIncr</td>
<td>Used to keep two management stations from modifying the same managed object at the same time.</td>
</tr>
<tr>
<td>AutonomousType</td>
<td>An OID used to define a subtree with additional MIB-related definitions.</td>
</tr>
<tr>
<td>VariablePointer</td>
<td>A pointer to a particular object instance, such as the ifDescr for interface 3. In this case, the VariablePointer would be the OID ifDescr.3.</td>
</tr>
<tr>
<td>RowPointer</td>
<td>A pointer to a row in a table. For example, ifIndex.3 points to the third row in the ifTable.</td>
</tr>
<tr>
<td>RowStatus</td>
<td>Used to manage the creation and deletion of rows in a table, since SNMP has no way of doing this via the protocol itself. RowStatus can keep track of the state of a row in a table, as well as receive commands for creation and deletion of rows. This textual convention is designed to promote table integrity when more than one manager is updating rows. The following enumerated types define the commands and state variables: active(1), notInService(2), notReady(3), createAndGo(4), createAndWait(5), and destroy(6).</td>
</tr>
<tr>
<td>TimeStamp</td>
<td>Measures the amount of time elapsed between the device's system uptime and some event or occurrence.</td>
</tr>
<tr>
<td>TimeInterval</td>
<td>Measures a period of time in hundredths of a second. TimeInterval can take any integer value from 0-2147483647.</td>
</tr>
<tr>
<td>DateAndTime</td>
<td>An OCTET STRING used to represent date-and-time information.</td>
</tr>
<tr>
<td>StorageType</td>
<td>Defines the type of memory an agent uses. The possible values are other(1), volatile(2), nonVolatile(3), permanent(4), and readOnly(5).</td>
</tr>
<tr>
<td>Tdomain</td>
<td>Denotes a kind of transport service.</td>
</tr>
</tbody>
</table>
Textual Convention | Description
---|---
TAddress | Denotes the transport service address. TAddress is defined to be from 1-255 octets in length.

**UDP**

UDP has been chosen and recommended for SNMP transport protocol. Initially, SNMP was targeted at managing Internet nodes and the predominant Internet protocol suite TCP/IP. The choice of TCP/IP suite is viable because IP became the protocol for commercial backbone networks and users can count on a TCP/IP implementation available on any type of host and router.

TCP and UDP provide transport services. However, UDP was preferred. This is due to TCP characteristics, it is a complicate protocol and it consume to many memory and CPU resources, whereas UDP is easy to build and run. Vendors have built simple versions of IP and UDP in devices (repeaters and modems). Thus the total software needed is small and can be stored in a ROM. UDP is well suited to the brief request / response message used in network management communication.

The SNMP protocol is UDP-based. Each message is sent in an atomic UDP packet. From RFC1157: "A message consists of a version identifier, an SNMP community name, and a protocol data unit (PDU)." Version is the SNMP version, community name is the password, and a PDU is just data.

**SNMP PDU**

There are five types of PDUs: Authorization

- **Get-request** - is used to request the values of one or more MIB variables.
- **Get-next-request** - is used to read variable values in the MIB sequentially. It is often used to read though a table of values. After a first read with the get-request, get-next-request is used to read the remaining rows.
- **Set-request** - is used to update an MIB value.
- **Get-response** - is returned as an answer to a get-request, a get-next-request or set-request message.
- **Trap** - is used to support significant events (e.g. a cold or a warm restart or a link that has gone down).
MibCompiler / Browser

The MibCompiler is a standard framework to compile and store MIB files that are represented in ASN1.0 format to a binary format. This manner of storing the MIB documents makes it easier to parse the document and represent it in a user understandable format.

The MIB Browser is an indispensable tool that can walk the user through the MIB trees, view MIB tables, search MIBs, remotely modify SNMP values, and perform many other SNMP functions.

The most critical part of a MIB Browser is the number of standard and proprietary MIBs it supports. Without the correct MIBs, the data collected from a remote device is difficult to interpret and use. TTW MIB Browser is shipped with over 10,000 precompiled unique OIDs from hundreds of standard and vendor MIBs.

Scope

The MibCompiler supports the following features.

- Parse the ASN format (.mib) file and convert it to a binary format
- Retrieve the different objects (Mib Objects/Traps) from the MIB file
- A Viewer is available to facilitate viewing the contents of the MIB file in a user understandable format
- Multiple MIBs can be compiled and stored in a single file
- Support nested compilation, collection of standard mibs along with installation.
- Caching compiled and imported mibs for interconnected MIB compilation.
- Providing help on all the above features

References and Terminology

The term MIB stands for Management Information Base, which is an integral part of the SNMP architecture. The MIB is a storage area for the resources being monitored. The description of this information is represented in an ASN1.0 format file. The MibCompiler parses these files in order to generate an output that can be used by the Manager System to procure information from the remote system’s MIB.

Architectural Overview

The MibCompiler has the following components.

- A customized parser that parses the MibComp generated output file
- A Program to configure Alerts, License etc
- A Viewer to browse through the contents of the Mib File
Note

The Parser API library from MibComp is used for parsing the (.mib) file.

The MibCompiler is used to compile MIB modules (and therefore, the trap definitions) and store into a binary file. The Manager when it receives a trap can lookup the trap definitions and use them to translate the trap into a user-friendly format before inserting into the Database. These translations are used by the Manager Console to show the trap information in a friendly format.

The Mib GUI is used to display the compiled contents of the MIB components in a user readable format. Multiple MIB components can be seen simultaneously.

Functional Definition

- Compile the Mib modules using the MibComp Compiler libraries to generate an intermediate format.
- Parse this intermediate format and convert it to a user comprehensible format that can be used by the TrapTracker and the Mib Console to display the Mib.

Note

The Mibs are stored in a binary format in the "mymibs.bin" file.
Starting MibCompiler

This option enables you to start MibCompiler.

To start MibCompiler

1. Double-click TrapTracker on the Control Panel.
   TrapTracker displays the TrapTracker Manager console.

2. From the Tools menu, choose MibCompiler.
   TrapTracker displays the MibCompiler console.
Understanding MibCompiler Console

The GUI contains five parts: Menu bar, Toolbar, Modules window, Module description window, Debugging window and Status bar.
Title Bar
The top strip of MibCompiler window is the Title Bar. The Title Bar shows the name of the application.

Menu Bar
The menu bar contains menus with relevant commands. From the menus, choose appropriate commands or use shortcut keys to execute the commands.

Tool Bar
The toolbar contains buttons with tool tips to perform basic tasks.

<table>
<thead>
<tr>
<th>Click</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder]</td>
<td>Compile a MIB module.</td>
</tr>
<tr>
<td>![File]</td>
<td>Save the compiled module(s).</td>
</tr>
<tr>
<td>![Trash]</td>
<td>Delete the compiled module(s).</td>
</tr>
<tr>
<td>![Search]</td>
<td>Search and find a word or phrase in Module Names, OidIdentifiers or Trap Names.</td>
</tr>
</tbody>
</table>
**Modules Pane**

It’s a resizable window; displays sorted list of all the compiled Mib modules.

**Module Details Pane**

It’s a resizable window; displays description of the module selected in Modules window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifier</td>
<td>Objects associated with the selected MIB.</td>
</tr>
<tr>
<td>Registration</td>
<td>Hierarchy details of the objects.</td>
</tr>
<tr>
<td>Type</td>
<td>Datatype of the objects:</td>
</tr>
<tr>
<td></td>
<td>table</td>
</tr>
<tr>
<td></td>
<td>row</td>
</tr>
<tr>
<td></td>
<td>counter64</td>
</tr>
<tr>
<td></td>
<td>objectid</td>
</tr>
<tr>
<td></td>
<td>bitstring</td>
</tr>
<tr>
<td></td>
<td>integer</td>
</tr>
<tr>
<td></td>
<td>octetctstring</td>
</tr>
<tr>
<td></td>
<td>ipaddress</td>
</tr>
<tr>
<td></td>
<td>Timeticks</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Access</th>
<th>Permission on manipulation of objects:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>read-write</td>
</tr>
<tr>
<td></td>
<td>not accessible</td>
</tr>
<tr>
<td></td>
<td>read-only</td>
</tr>
<tr>
<td></td>
<td>counter</td>
</tr>
<tr>
<td></td>
<td>gauge</td>
</tr>
<tr>
<td></td>
<td>-none-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Status</th>
<th>Status of the objects:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>current</td>
</tr>
<tr>
<td></td>
<td>mandatory</td>
</tr>
<tr>
<td></td>
<td>deprecated</td>
</tr>
</tbody>
</table>

| Description  | Description of the objects.                    |

**Debugging Pane**

It’s a resizable window; displays success / failure status of the compiled MIBs and other debugging information.
Status Bar
Activity status of MiB Compiler like Ready, Compiling is displayed here.

Need for MiB Compilation

TTW is incapable of interpreting the traps sent by the SNMP compliant devices in human understandable form when there is no reference to those traps in the bin file. For example, the following figure displays the varBinds associated with their respective traps in the All Traps window, which is incomprehensible to the end-user.

But when the MiB module PMI-Sys-MIB, which is the enterprise specific MiB is compiled and saved, TrapTracker Manager displays the varBinds associated with that MiB in user comprehensible way.
So it is mandatory to compile the enterprise specific MIBs and save them in bin file.

Compiling a Single MIB Module

This option enables you to compile a single MIB module.

To compile a single MIB module

1. Open the MibCompiler console.
2. From the File menu, choose Compile one MIB.
   (OR)
   Press Ctrl + N on your keyboard.
   (OR)
   Click on the tool bar.
   MibCompiler displays “Open MIB file” window.
3 Go to the appropriate folder and select the MIB file that you want to compile.

4 Click Open.

MibCompiler displays the confirmation message box.

5 Click Yes to start compilation.

TrapTracker displays the compilation success / failure status in the debugging window.
6. From the File menu, choose Save.
   (OR)
   Press Ctrl + S on your keyboard.
   (OR)
   Click on the tool bar to save.

   MibCompiler displays the “Restart Services” confirmation message box.

   Click Yes to restart the dependent services.
Compiling Multiple MIB Modules

In group compilation mode you can compile a group of related MIB modules. The MibCompiler randomly chooses the MIB modules irrespective of their dependency and compiles iteratively. Consider there are three MIB modules “A”, “B” and “C”, where “C” has dependency on “B” and in turn “B” has dependency on “A”. Suppose TrapTracker compiles “C” first, the compilation will complete with errors since “C” has dependency on “B”. But the MIB module that has no reference will get compiled successfully without errors; in this case “A”. The MIB modules, which are compiled successfully, will also be compiled for every iteration. You can refer the gcreport.txt, which is generated by the MibCompiler for group compilation or the debugging window to get to know what has happened to your MIB modules and compile them iteratively until all the modules are compiled successfully. If there are references in a MIB module to other modules, which could not be resolved, then the compilation process terminates unsuccessfully, irrespective of the number of iterations you attempt. The gcreport.txt is
generated only for group compilation and not for single Mib compilation. Its contents are overwritten for every compilation.

This option enables you to compile multiple MIB modules.

To compile multiple MIB Modules

1. Open the MibCompiler console.
2. From the File menu, choose Compile multiple MIBs.
   (OR)
   Press Ctrl + G on your keyboard.
   MibCompiler displays “Browse for Folder” window.
3. Go to the appropriate drive and select the folder that you want to compile.
4. Click OK.
   MibCompiler displays the confirmation message box to proceed further.

Figure 98 Browse for Folder dialog box.

Figure 99 Proceed? message box.
5 Click **Yes** to start compilation.

TrapTracker displays the compilation success / failure status in the debugging window.

```
MbComp: Group compilation node.
MbComp: compiling module 'C:\MIBs\Common\mdsreg.mib'
C:\MIBs\Common\mdsreg.mib:61: date specification '0301210000Z' contains an illegal value
C:\MIBs\Common\mdsreg.mib:72: revision for last update is missing
MbComp: compiled module 'C:\MIBs\Common\mdsreg.mib' with errors/warnings

Compiled Successfully: MDS-REG.mib inserted.
```

```
MbComp: Group compilation node.
MbComp: compiling module 'C:\MIBs\Common\mds_comm.mib'
C:\MIBs\Common\mds_comm.mib:281: date specification '0301210000Z' contains an illegal value
C:\MIBs\Common\mds_comm.mib:294: revision for last update is missing
MbComp: compiled module 'C:\MIBs\Common\mds_comm.mib' with errors/warnings

Compiled Successfully: MDS-COMMON-MIB.mib inserted.
```

Compiled Successfully: MDS-COMMON-MIB.mib inserted.
Compilation completed
Select save from menu or toolbar to save the added MIB to disk

Refer: C:\Program Files\Prism Microsystems\TrapTracker\acreport.txt file for consolidated compilation report.

6 From the **File** menu, choose **Save**.

(OR)

Press **Ctrl + S** on your keyboard.

(OR)

Click **[ ]** on the tool bar to save.

MbCompiler displays the "Restart Services" confirmation message box.

![Restart Services](image)

1 Click **Yes** to restart the dependent services.
Saving MIB Compilation Report

By default, MibCompiler generates gcreport.txt for group compilation. Apart from this, you can manually copy, paste, delete, save and organize those details in separate text files for future reference for group compilation and single Mib compilation.

This option enables you to save the Mib compilation report in a text file.

To save MIB compilation report
1. Right-click the debugging window.
   MibCompiler displays the shortcut menu.
   From the shortcut menu, choose Select All and then Copy.
2. Create a text file and paste the copied details in that text file.
   You can also select and copy a portion of the details.

Viewing MIB Details

This option enables you to view the MIB details.

To view MIB details
1. Open the MibCompiler console.
2. From the View menu, choose Mibs.
   (OR)
   Press Ctrl + M on your keyboard.
   By default, MibCompiler selects this view.
3. Select a MIB module on the Modules window.
   MibCompiler displays the details of the selected MIB in the Details window.
4. Double-click an object on the "Details" window.
   MibCompiler displays the details of the selected object.
Viewing Trap Details

This option enables you to view the trap details.

To view trap details
1. Open the MibCompiler console.
2. From the View menu, choose Traps.
   (OR)
   Press Ctrl + T on your keyboard.
   MibCompiler displays all traps in the "Details" window.

Figure 102 Details of node: sysTicks.
Double-click the trap that you want to view details.

MibCompiler displays the details of the selected trap.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the trap.</td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>Name of the enterprise that defined the trap.</td>
</tr>
</tbody>
</table>
### Browsing MIB Tree

This option enables you to search through the MIB tree for an MIB, OID, Identifier and Trap names. Searching with regular expression is not permitted.

#### To browse the MIB tree

1. Open the MibCompiler console.
2. From the **Tools** menu, choose **Find**.
   (OR)
   Press `Ctrl + F` on your keyboard.
   (OR)
   Click [ ] on the tool bar.

MibCompiler displays "Find" dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise Oid</td>
<td>Object id of the trap.</td>
</tr>
<tr>
<td></td>
<td>1 – ISO</td>
</tr>
<tr>
<td></td>
<td>3 – ORG</td>
</tr>
<tr>
<td></td>
<td>6 – DOD</td>
</tr>
<tr>
<td></td>
<td>1 – Internet</td>
</tr>
<tr>
<td></td>
<td>4 – Private</td>
</tr>
<tr>
<td></td>
<td>1- Enterprise</td>
</tr>
<tr>
<td></td>
<td>7011 – pmiSystem</td>
</tr>
<tr>
<td></td>
<td>1 – pmiSystrap</td>
</tr>
<tr>
<td>Variables</td>
<td>varBinds associated with the trap.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the trap.</td>
</tr>
</tbody>
</table>
Note

By default, MibCompiler displays the MIB modules and the details of those modules. To view the trap details, follow the procedures in the View Trap Details section.

3 Type the name of a module in the search field.
4 Select Module Names option, if not selected.

5 Click Ok.

MibCompiler displays the MIB module and its details.
6 Type an **OID** in the search field.

7 Select the **Oid** option.

8 Click **Ok**.

MibCompiler displays the result.
9 Type an **Identifier** in the search field.

10 Select the **Identifier** option.

11 Click **Ok**.

MibCompiler displays the result.
Searching Trap Details

This option enables you to search the Trap details.

To search trap details
1. Open the MibCompiler console.
2. From the View menu, choose Traps.
(OR) Press Ctrl + T on your keyboard.

MibCompiler displays all trap details.
From the Tools menu, choose Find.

(OR)

Press Ctrl + F on your keyboard.

(OR)

Click on the tool bar.

MibCompiler displays the “Find” dialog box.

4 Type the name of the trap in the search field.
Deleting MIB

This option enables you to delete a MIB from the bin file.

5 Click Ok.

MibCompiler displays the result.
To delete a MIB

1. Open the MibCompiler console.
2. Select the module that you want to delete from the “Modules” window.
3. From the File menu, choose Delete.
   (OR)
   Press Ctrl + D on your keyboard.
   (OR)
   Click on the tool bar.
   MibCompiler displays the Mib Compiler confirmation message box.
4. Click Yes.
   MibCompiler displays the Mib Compiler message box with appropriate message.
5. Click OK.

Exiting MibCompiler

This option enables you to exit MibCompiler.

To exit MibCompiler

1. From the File menu, choose Exit.
   MibCompiler displays the “Save?” confirmation message box.
2 Click **Yes** to save the changes you have made and exit the MibCompiler.

3 Click **No** to exit MibCompiler without saving the changes.

MibCompiler displays the “Restart Services” message box.

4 Click **Yes** to restart the dependent services.
## Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert Configuration</td>
<td>Process of configuring alert notifications in the form of Sound, E-mail, Console message or any Custom action.</td>
</tr>
<tr>
<td>Alerts</td>
<td>A feature that instructs programs to notify timely information about the events.</td>
</tr>
<tr>
<td>ASN-1</td>
<td>Abstract Syntax Notation One (ASN.1) is an internationally accepted formal language or notation system used for describing data to be exchanged between distributed computer systems or by telecommunications protocols, regardless of language implementation, physical representation of these data, or type of application. It is a formal system for the specification of abstract data types. ASN.1 uses sets of encoding rules to transform data specified in the ASN.1 language into a standard format that can be decoded on any system that 'knows' the same rules.</td>
</tr>
<tr>
<td>Audible Alert</td>
<td>A feature that instructs programs that usually notifies information by sound.</td>
</tr>
<tr>
<td>Console Message Alert</td>
<td>A feature that instructs programs to notify information to the selected machine.</td>
</tr>
<tr>
<td>Custom Alert</td>
<td>A feature that instructs programs to execute custom action on receipt of an event.</td>
</tr>
<tr>
<td>Email Alert</td>
<td>A feature that instructs programs to notify information by E-mail.</td>
</tr>
<tr>
<td>Entity</td>
<td>Refers to both a server and a client.</td>
</tr>
<tr>
<td>Event</td>
<td>A condition or state of change that may cause a trap message to be generated.</td>
</tr>
<tr>
<td>Filters</td>
<td>The process to filter out events that you do not want to monitor.</td>
</tr>
<tr>
<td>Historical Report</td>
<td>The report generated based on the selection criteria.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hubs</td>
<td>A common connection point for devices in a network. Hubs are commonly used to connect segments of a LAN. A hub contains multiple ports. When a packet arrives at one port, it is copied to the other ports so that all segments of the LAN can see all packets. A passive hub serves simply as a conduit for the data, enabling it to go from one device (or segment) to another. So-called intelligent hubs include additional features that enable an administrator to monitor the traffic passing through the hub and to configure each port in the hub.</td>
</tr>
<tr>
<td>IP Subnet</td>
<td>A 32-bit address used to identify a node on an IP internet. The address is typically represented with a decimal value of each octet separated by a period. For example: 192.168.7.27.</td>
</tr>
<tr>
<td>Logfiles</td>
<td>The process to monitor textual log files such as SQL or ISA logs, created by any vendor. You can also configure the strings to search. If any record matching the search string is found, an event will be generated.</td>
</tr>
<tr>
<td>MIB</td>
<td>Management Information Base; a collection of managed objects residing in a virtual information store.</td>
</tr>
<tr>
<td>Network element</td>
<td>Also known as a managed device- a hardware device, such as a PC or a router.</td>
</tr>
<tr>
<td>NOC</td>
<td>Network Operations Center. A location from which the operation of a network is monitored. Additionally, this center usually serves as a clearinghouse for connectivity problems and efforts to resolve those problems.</td>
</tr>
<tr>
<td>Notification</td>
<td>A message that indicates a status change (equivalent to a trap).</td>
</tr>
<tr>
<td>Objects</td>
<td>A passive entity that contains or receives information. Access to an object potentially implies access to the information it contains. Examples of objects are: records, blocks, pages, segments, files, directories, directory trees, and programs, as well as bits, bytes, words, fields, processors, video displays, keyboards, clocks, printers, network nodes, etc.</td>
</tr>
<tr>
<td>OID</td>
<td>An Object Identifier (OID) is the identification value of an object that is defined in a MIB. OIDs are arranged in a hierarchical tree structure compliant with Internet standard, that consists of roots and branches. An OID is written as a sequence of sub identifiers, starting with the tree root in dotted decimal notation. For example, the Microsoft branch of the MIB naming tree is expressed as 1.3.6.1.4.1.311.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Parse</td>
<td>Using algorithms to analyze data into components. Semantic parsing involves trying to figure out what the components mean. Lexical parsing refers to the process of deconstructing the data into components.</td>
</tr>
<tr>
<td>Protocol</td>
<td>A set of rules that computers use to communicate across networks on the internet.</td>
</tr>
<tr>
<td>Router</td>
<td>A device that determines the next network point to which a data packet should be forwarded en route toward its destination. The router is connected to at least two networks and determines which way to send each data packet; based on its current understanding of the state of the networks it is connected to. Routers create or maintain a table of the available routes and use this information to determine the best route for a given data packet.</td>
</tr>
<tr>
<td>SMI</td>
<td><strong>SMI</strong> stands for Structure of Managed Information and represents the notation by which an SNMP MIB must be written. Another way to look at SMI is that it is the grammar to write SNMP MIBs. There are two types of SMI: SMIv1 and SMIv2 with SMIv1 being the earlier version, of course, back in 1990. <strong>SMIv1</strong> is the old notation that nobody should use anymore. However, there are still a lot of SNMP MIBs written before SMIv2 came about in 1993. <strong>SMIv2</strong> is the new notation that you should use whenever you create a new MIB.</td>
</tr>
<tr>
<td>SNMP</td>
<td>Simple Network Management Protocol -- A set of standards for communication with devices connected to a TCP/IP network. Examples of these devices include routers, hubs, and switches. A device is said to be “SNMP compatible” if it can be monitored and/or controlled using SNMP messages. SNMP messages are known as “PDU’s” - Protocol Data Units. Devices that are SNMP compatible contain SNMP “agent” software to receive, send, and act upon SNMP messages. Software for managing devices via SNMP are available for every kind of commonly used computer and are often bundled along with the device they are designed to manage.</td>
</tr>
<tr>
<td>SNMP Community Strings</td>
<td>An SNMP community string is a text string that acts as a password. It is used to authenticate messages that are sent between the management station (the SNMP manager) and the device (the SNMP agent). The community string is included in every packet that is transmitted between the SNMP manager and the SNMP agent.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SNMP Traps</td>
<td>The process to receive trap messages generated by local or remote SNMP agents and forwards the messages to third party vendor software such as an NOC.</td>
</tr>
<tr>
<td>Switch</td>
<td>A device that improves network performance by segmenting the network and reducing competition for bandwidth. When a switch port receives data packets, it forwards those packets only to the appropriate port for the intended recipient. This further reduces competition for bandwidth between the clients, servers or workgroups connected to each switch port.</td>
</tr>
<tr>
<td>TCP</td>
<td>Transmission Control Protocol. TCP is responsible for verifying the correct delivery of data from Agent to server. TCP adds support to detect errors or lost data and to trigger transmission until the data is correctly and complete received.</td>
</tr>
<tr>
<td>Trap</td>
<td>Message sent by an SNMP server to a client to indicate the occurrence of a significant event, such as a specifically defined condition or a threshold that was reached. Managed devices use traps to asynchronously report certain events to clients.</td>
</tr>
<tr>
<td>UDP</td>
<td>User Datagram Protocol. A connectionless protocol that, like TCP, runs on top IP networks. Unlike TCP/IP, UDP/IP provides very few error recovery services, offering instead a direct way to send and receive datagrams over an IP network.</td>
</tr>
</tbody>
</table>
# Index

## A
- Adding a system
  - new ........................................... 34
- Alert actions
  - audible alert ................................ 48
  - console message ............................ 53
  - custom action ................................ 55
  - e-mail ........................................ 51
  - modifying ..................................... 60
- Alerts
  - adding ........................................ 45
  - deleting ...................................... 62
  - modifying .................................... 58
- Auto Acknowledge
  - traps .......................................... 38
- Auto Scroll
  - auto scroll .................................. 33

## B
- Browsing MIB tree
  - search and find ............................. 119

## C
- Categories
  - adding trap details ....................... 67, 75
  - categories .................................. 64
  - creating ..................................... 64
  - deleting ..................................... 74
  - deleting trap details ...................... 79
  - exporting .................................... 80
  - import/export ................................ 80
  - importing .................................... 82
  - modifying .................................... 73
  - modifying trap details .................... 78
  - report/history ................................ 70
- Clear/Acknowledge
  - clearing/acknowledging ................... 32
  - multiple traps ................................ 32
  - selected system ............................. 33
  - single trap .................................. 32
- Compiling MIB
  - compiling .................................... 110
  - multiple MIBs ................................. 113
  - need for compilation ...................... 109
  - saving report ............................... 116
  - single MIB .................................. 110

## D
- Database
  - database ...................................... 11

## E
- Exiting
  - TTW Manager ................................. 36

## F
- Filters
  - adding ........................................ 39
  - deleting ...................................... 44
  - modifying .................................... 42

## L
- License
  - upgrading .................................... 35

## M
- MIB
  - compiler/browser ........................... 103
  - deleting ..................................... 125
  - groups of MIB-II ............................. 97
  - MIB ........................................... 95
  - MIB-II tree .................................. 96
  - viewing details .............................. 116
- MibCompiler
  - compiler ....................................... 11
  - exiting ....................................... 126
  - starting ...................................... 105
  - understanding the console ............... 106

## P
- Parse
parse......................................10, 130

R

Reports
reports ...........................................83
reports/history.................................84

S

SMI
SMI ................................................93
SMIV2 textual conventions ...........101
SNMP ...........................................10
PDU .............................................102
SNMP ...........................................93
SNMPv1 datatypes .........................98
SNMPv2 datatypes .........................100
SNMPv2 object definition .............100

T

Trap details
selected system..............................30
viewing........................................117

Trap windows
creating......................................16
renaming......................................20
trap windows.................................16

TrapTracker Components
components ...................................10

TrapTracker for Windows
TrapTracker ....................................10
TTW ...............................................10

TrapTracker Manager
manager .........................................11
TTW Manager Console
Manager console ..........................13

U

UDP
UDP ...........................................102

W

Window properties
viewing........................................26